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CHAPTER 1
Introduction

P rojecting future performance in finance is rarely an endeavor that will lead to
results that exactly mimic reality. Equity products vary as the market evolves,

seemingly simple fixed-income products may fluctuate in value due to changing
interest rates, and overall most financial products have an ebb and flow of value.
None of this is shocking, since much of finance is about the risk of the unknown.
Understanding, measuring, and making decisions with future performance risk in
mind is the focus of most financial professionals’ day-to-day jobs. To understand
this risk, models can be built to project what would happen given a set of certain
circumstances. Depending on the sophistication of the financial analyst and the
level of detail justified for a transaction, a range of techniques are available. The
most basic isolated calculations form the starting point for these techniques, which
then become more complicated when interconnected concepts are tied together
in a deterministic model, and eventually a simulation may be constructed when a
simple closed form solution is not appropriate or even possible. This book intends
to focus on the last of those three methods, simulation, by taking readers through
basic theory and techniques that can be instantly applied to a variety of financial
products.

WHAT IS SIMULATION?

In general, simulation is typically a process that attempts to imitate how events
might take place in real life. Simulations can be extraordinarily simple, such as
conducting a mock interview with a peer, or incredibly complex, such as using a
flight simulator to mimic a Mars landing. A simulation can also be for a tangible
real-life process or for something abstract. For instance, the military often engages
in simulations that try to replicate real-life war scenarios. Soldiers storm faux
buildings with people playing different roles in accordance with situations they
would expect in a real war. However, there are also abstract simulations such as
those conducted in finance.

Even though simulations in finance may be somewhat intangible, the events
that we worry about are very real. Perhaps a fund manager has a portfolio of
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2 FINANCIAL SIMULATION MODELING IN EXCEL

corporate exposures. The most obvious real-life event that would be of concern
is the default of one or more of these corporate exposures. Simulating defaults
would be an important exercise for the fund manager to undertake. Similarly, a
fixed-income specialist might invest in fixed-rate products; however, the specialist
might be funded by floating rate debt returns. Basis risk exists in such a system,
and the evolution of interest rates is the real-life event that the specialist would
worry about. A simulation of interest rates could greatly help the specialist design
a portfolio to reduce risk.

CHARACTERISTICS OF A SIMULATION

Regardless if one is entering into a military simulation or creating a code-based
simulation, there are similarities. The starting point for most simulations is the
assumptions that go into it. For a military simulation that is preparing for urban
warfare, this might include the number of soldiers per unit, the weapons and sup-
plies that each solider carries, the standard and unique training of the soldiers, and
the possible buildings, enemies, weather, and so forth that they could encounter.
In a financial simulation, such as the corporate default example, you might have
characteristics of the companies, such as the industry, regional operating location,
historical asset levels, historical liability levels, and so forth.

Once the assumptions of the topic that we are trying to simulate are under-
stood, a method for assembling the system and rules for how the system works
are required. In our military simulation example, we would have a training area
where the soldiers arrive with all of the training and gear one would expect, and
then have an area with buildings and enemies they would expect to face. A mission
with an objective would be established, and certain rules might be integrated to
help make the simulation as real as possible. For instance, even though a soldier
could theoretically leave the simulation area to get around an obstacle, a rule
could define the simulation area and state that soldiers are not allowed to go be-
yond its perimeter. Similarly, in a financial simulation we would need a medium
in which to conduct the simulation, which in modern times is done within the
confines of a computer application. We program rules to guide our assumptions’
behavior through processes that simulate how real-life events might unfold.

Another characteristic of simulations is that they may be repeated to determine
varying outcomes. In the military situation, soldiers may choose one path through
the buildings in one iteration of the simulation and then choose a different path
in another iteration. The outcomes in both scenarios could be markedly different.
Similarly, in a financial simulation asset levels for the same company in a future
period could be assumed to be different from one simulation iteration to the next.
This could mean that the default outcomes are also different.

At the end of the simulation, there should always be an analysis. Multiple
aspects of the military simulation would be analyzed, such as speed of completion
of the simulation, effectiveness at achieving the mission objective, supplies used,
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FIGURE 1.1 Most simulations will follow a similar process of selecting or
creating assumptions, constructing a simulation environment with rules,
analyzing the outcome, and possibly repeating the process.

and so forth. In the financial simulation, we would want to see the frequency of
companies defaulting, which types of companies defaulted, the characteristics of
those companies, the balance of exposures for the ones defaulting, the time at
which they defaulted in the future, and so forth.

Finally, we should be concerned about the validity of our results. Numerous
flaws could occur in the construction of the military simulation. Perhaps the
individuals posing as enemy soldiers are not as aggressive as in real life or the
equipment used is different. In the financial simulation, perhaps we assumed
lower correlation than really exists or measured historical volatility wrong. All of
these could lead to error that should be taken into account. See Figure 1.1.

INSTRUCTIONAL METHODOLOGY

Financial simulation can be a tricky subject for readers and authors since people
have a multitude of reasons for using simulation in finance. To approach this
unique issue, the book is laid out in a specific manner. Chapters 2 and 3 are what
I would call “tool set” chapters. They focus on core elements of simulations that
are inherent to most financial simulations (and to many simulations in other fields
as well). Chapter 2 works through random number generation and eventually
to explaining a common term heard in finance, Brownian motion. After that, in
Chapter 3, correlation between variables is explained with examples on how cor-
related random numbers are generated. These tools are invaluable for constructing
simulations and require a thorough understanding. For instance, one of the most
common errors I have noticed financial analysts make when implementing simu-
lations for the first time is an incorrect method of generating random numbers.
Similarly, incorrectly accounting for correlation can lead to massive problems in
a simulation.
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4 FINANCIAL SIMULATION MODELING IN EXCEL

FIGURE 1.2 The chapters in this book follow a logical and intended order.

Once the tools are developed, readers begin to use them for different purposes.
Chapter 4 takes readers through simulating interest rate paths to price bonds using
methods credited to Hull and White. Chapter 5 expands the reader’s knowledge
of simulation by creating a corporate default simulation based on structural and
reduced form models. Default is taken further in Chapter 6 with a thorough
look at simulating pools of assets. Clearly, as authors, we cannot anticipate every
reader’s specific need, but the topics we have chosen reflect the most frequent and
current topics related to simulation.

Finally, integrated throughout the chapters, but also a focus of chapters them-
selves is analysis, interpretation, and advanced thoughts on the simulation process.
Chapter 7 shows readers data deficiencies and how to manage data as it relates to
a simulation. Exercises, in the form of Model Builder examples, are used to help
demonstrate these concepts. Although not as technically demanding, these sec-
tions should not be skipped over since they focus on the proper use of simulation;
which is just as important as implementing it correctly. See Figure 1.2.

HOW THIS BOOK WORKS

There are notable differences and many similarities between this book and the
others in my Step-by-Step Guide series. All rely on theory and practical exercises
to transform financial concepts into dynamic, usable models. A common theme to
the other books is that they work through individual “modules” that culminate
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Introduction 5

in a single complete model. While this book has readers work through similar
“modules,” chapter after chapter, instead of creating a single unified model the
Model Builders produce multiple, smaller models. This is not to say that they
are less complex; in fact, many of the models in this book are technically and
mathematically more complex than the other books. The use of multiple models
is necessary because simulation has its place in many parts of finance, and using
a single unified model would be illogical and inappropriate.

Whether you are familiar with the other books or new to the series, you will
find that each section begins with a discussion of theory and then moves on to a
Model Builder exercise, where the theory is transferred to an application in Excel.
Eventually as all theoretical concepts are read and Model Builder steps completed
the reader should have operational examples that are identical to the ones included
on the website that accompanies this book. Readers should make every attempt
at constructing the models themselves, since this is the best way to learn and
understand every aspect of the models. If any part of the text seems unclear a
reader should leverage the completed models on the website to understand every
section.

While financial theory and implementation are two critical elements in learn-
ing proper modeling techniques, one of the biggest challenges of creating an
instructional book is the different skill levels of readers. Some readers have a deep
understanding of the theory and are really searching for practical techniques to
create usable Excel/Visual Basic Applications (VBA) based solutions, while others
may come from a very technical background and understand the mechanics of
Excel/VBA but are more interested in learning what body of knowledge exists and
how it ties into finance. For this reason, readers will notice various attempts at
making the text applicable for the widest possible audience.

A balance has been attempted on both the theoretical and technical level. For
the theory sections, enough background and mathematical formulas are provided
to introduce, elucidate, and reinforce the section we are focusing on. However,
this book is purposely not set up to list out and derive all formulas, nor does it
intend to explicate in detail the origination of every concept. Enough theory is
provided to understand what it is we are discussing, why it is important in finance,
and how the analytical method that is provided can be used.

The technical level of this book starts out fairly simple, but it gets more
complex in later chapters. For each chapter we strive to demonstrate the theory
behind what we are discussing by first using Model Builder examples that operate
entirely on the sheet without the use of VBA. However, Excel is a poor medium
for simulation and VBA used within Excel’s provided Visual Basic Editor (VBE)
is a better environment to practically implement simulations. With this in mind
we have provided VBA-based examples to many of the most important sections.
We have tried to keep the coding straightforward for those who may be new to
or at a beginner level of the VBA language.

Given that some readers will be on an extreme end of the spectrum, either
completely new to financial simulation or advanced in the field, we have created

htt
p:/

/w
ww.pb

oo
ks

ho
p.c

om



P1: a/b P2: c/d QC: e/f T1: g

JWBT550-c01 JWBT550-Allman July 8, 2011 23:26 Printer Name: Yet to Come

6 FINANCIAL SIMULATION MODELING IN EXCEL

an appendix to prevent the burden of too much off-topic or advanced information
for the average reader. For instance, background mathematical concepts may be
necessary for some readers, while some advanced topics discussed may pique
advanced readers’ interest. Rather than leave such readers without a resource
or with the thought that some sections ended too quickly, we have included
background mathematics and more advanced implementations in the Appendix.
The complementary, completed Excel/VBA files related to these discussions are
available on the book’s website.

ABOUT THE COMPANION WEBSITE

It is clear that technology is changing how we take in information. You may be
reading this book in digital form via an e-reader of some type. As digital media
becomes a larger market, technical books like this have to adapt to provide all of
the information necessary for readers. The previous Step-by-Step books included
CD-ROMs to deliver the electronic information, such as the Model Builder files.
Now we are moving to a web-based solution where users can download the files
wherever they have an Internet connection.

Since my training website Enstruct, www.enstructcorp.com, is already estab-
lished with errata for the previous books and additional financial modeling exer-
cises, the files for this book can be downloaded from the site. To go to the secure
file directory for this book, go to www.wiley.com/go/financialsimulationmodeling
and enter the following:

Password: fsm2012
If there are any technical issues with the website, please e-mail:

info@enstructcorp.com.

EXCEL 2003 AND EARLIER VERSUS EXCEL 2007/2010

We are at a time when there are many users who have switched to Excel 2007
or Excel 2010 and a few who are still using Excel 2003. While the powerful
differences between 2003 and 2007/2010 versions of Excel are related to memory
accessibility and usage, there are major shifts in the menus. This text will provide
instructions assuming the reader is using Excel 2007/2010. If any users of 2003
or earlier encounter problems, they should contact the authors for assistance.

More important for this book are the differences between Excel versions in
respect to VBA. There are differences between 2003 and 2007/2010, particularly
since Add-In files, extension names, and references may be slightly different. For
instance, 2007/2010 macro-enabled files end in .xlsm rather than .xls. Similarly,
Add-Ins end in .xlam in 2007/2010 rather than .xla. Another critical difference
is that Excel 2007/2010 provides readers the option to save their file in a macro-
free workbook. Users of this book should be careful of this option when creating
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Introduction 7

FIGURE 1.3 Be careful of the differences in file saving between Excel 2003 and Excel 2007/2010.

code or using downloaded files from the website. If a file with VBA code is
saved as a macro-free workbook, then all of the code is removed and the code
functionality lost.

Another key caveat is that users who are using Excel 1997 or earlier may
encounter serious problems since there were many updates to VBA after that
version. If there are any Excel error problems, I will once again reiterate to check
the complete Model Builder files on the website, and if the solution is not clear to
contact the authors. See Figure 1.3.

A final word about Excel versions relates to Mac users. The Excel 2008
version on Mac does not allow for the use of VBA. However, the 2011 version
does. Mac users running Excel 2008 should be careful when opening Excel files
with VBA from the website.

A FEW WORDS ABOUT SEMANTICS

Learning about financial modeling can be tricky in written instructional form
since words translate into commands, which can be very specific for computer
programs. To avoid confusion, the following is a quick guide to the words that
are used in this text and how they translate into the required actions the reader
must perform. The key is to understand that there are four main operations we
will perform on a cell and a fifth word to be aware of:

Enter a value. When the Model Builder exercises ask for a value to be entered,
this will be a number, date, or Boolean (TRUE or FALSE) value. These are values
that will be referenced for some type of calculation purpose.

Enter a label. A label is text in a cell to help the model operator understand
values and formulas in relative proximity. Note that I use the word as a verb as
well. For example, I may say label A1, “Project Basic Cash Flow”. This means
that the text “Project Basic Cash Flow” should be entered into A1. Also, there are
times when I will use the word label with a number. This means that a number
will be used as a label and not referenced in the actual calculation on the sheet or
be used by the VBA code. Mostly these types of numbers will be used to describe
time periods.

Name a cell or range of cells. Not to be confused with labeling, naming is a
specific technique that converts the reference of a cell or range to a user defined
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8 FINANCIAL SIMULATION MODELING IN EXCEL

name. This is done using the Name Box in the upper left corner of the Excel
application or by selecting the Formulas tab and selecting the Name Manager
button. In the Name Manager dialogue boxes, you can create, edit, and/or delete
named references. It is particularly important to name a cell or range of cells as
commanded if VBA code is being used for the Model Builder. This is because the
name will be used in the code to reference the cell or range on the sheet. If the
name does not exist the code will break down with an error.

Enter a formula. The core reason we are using Excel is for calculation pur-
poses. A formula is initiated in Excel with the “=” sign. When I state to enter
a formula, I will provide the cell it should be entered in and the exact formula
that should be entered. Often I have copied the formulas from the Excel models
themselves to ensure that the text exactly corresponds to the example models
provided on the website.

Function. Be careful with the difference between a formula and function, as
some people are used to hearing “Look at the function in A2” or “Enter the func-
tion there.” The word function in this book can be used in a few ways. The most
common way is when readers are instructed to use a pre-defined Excel function
such as SUM, NORMSDIST, AVERAGE, and so forth. These are functions that
are already created in the Excel Worksheet Function library and require the user
to type only the name with parameters in parentheses to return a value. You will
also hear the word function used when we describe the theoretical formulas that
underpin the topics being taught. Readers should be aware that the use of the word

FIGURE 1.4 Commands in this book should be followed as
described in the figure and in the text preceding it.
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Introduction 9

is to help explain the formula at hand. Finally, the word function may show up in
certain sections where VBA is used. In VBA, users can use functions from many
precreated libraries or create their own functions for use on the sheet or within
VBA modules. If we use the word function in that context, it means we are most
likely talking about a function that returns a value in the code. See Figure 1.4.

MODEL BUILDER 1.1: Initial Settings

With the first Model Builder, we should take a moment to understand how the Model Builder sections
differ from other parts of the book. Each Model Builder is an instructional section that should be
completed with the use of a computer running Excel. It should be followed step-by-step using
the instructions. Each Model Builder assumes that each step in the Model Builder was read and
implemented. The eventual result of the Model Builder sections is a complete version of the model
we are discussing. Versions completed by the authors reside on the book’s companion website. If
at any point you find yourself lost you should open the corresponding completed file on the website
to see how the relevant section should be completed.

This first Model Builder is to make sure that our versions of Excel are all set to identical settings.
Depending how you installed Microsoft Excel or Office you may need the installation disc to enable
all of these settings.

First, we will be using a few functions and tools that require the Analysis Tool Pak, Analysis
Tool Pak VBA, and Solver Add-Ins to be installed. To do this:

For Excel 2007: Select the Office button, select Excel Options, select Add-Ins, and then select
the Go button, which is to the right of Manage and a box that should default to Excel Add-Ins. This
will bring up the same box as in Figure 1.5. Check the boxes for Analysis Tool Pak, Analysis Tool Pak
VBA, and Solver. Select OK. If the Add-Ins are not installed it may prompt you with a few messages
stating that Excel will need to install them. Depending on how Excel was initially installed, you may
need the installation disc to complete the install.

For Excel 2003 and earlier: Select Tools, select Add-Ins, and check the boxes for Analysis Tool
Pak, Analysis Tool Pak VBA, and Solver. Typically the Analysis Tool Pak and the Analysis Tool Pak
VBA are the first two Add-Ins on the Add-Ins list. Solver is usually at the bottom. Select OK. If the
Add-Ins are not installed, it may prompt you with a few messages stating that Excel will need to
install them. Depending on how Excel was initially installed, you may need the installation disc to
complete the install. Figure 1.5 depicts the Add-In selection box.

The next setting we should set is the ability to run macros. We will add significant functionality
through the use of VBA. If you would like to take advantage of this you will need to continue on to
step 3.

For Excel 2007: Excel 2007 requires a bit more setup to work with macros. Select the Office
button, and select Excel Options. On the default tab, the Popular tab, check the third check box
down, “Show the Developer tab in the Ribbon.” Press OK. Once the Developer tab is visible, select
it and then select Macro Security. In Excel 2007 you have four options for Macro settings, three of
which are similar to Excel 2003. The only exception is that you can disable all macros except ones
with a digital signature. Since hardly anyone has taken Microsoft up on its security measures and
people rarely use digital signatures for Excel files, we will ignore that option. We can safely set it to
disable all macros with notification. The notification will occur when the workbook is opened and
will be a button with “Options. . .” in it at the top of the sheet or through a dialogue box asking you
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10 FINANCIAL SIMULATION MODELING IN EXCEL

FIGURE 1.5 The Add-In selection box allows users to install precreated or user-created
Add-Ins.

to enable macros. All workbooks from this book’s website can be accepted, as they are virus-free.
An example of one of these dialogue boxes is shown in Figure 1.6. In Excel 2007 you should not
have to restart Excel for this to take effect.

For Excel 2003 or earlier: Select Tools, select Macros, select Security. You have the choice of
either Low, Medium, or High. Low will allow macros without prompting, Medium will prompt you
to enable or disable macros within a workbook when it is opened, and High disables macros in a
workbook. The main concern is that viruses can be built into macros, which can cause significant
damage or security concerns. All VBA subroutines and functions in this book contain no viruses
and can safely be opened with macros enabled. You may want to set your computer to medium
security so that you enable only trusted workbooks. For the changes to take effect, you must shut
down Excel and reopen it. When prompted, enable macros for each file by selecting Enable.

Once the Add-Ins are installed and the macro security is set, we can actually start constructing
our models. At this point we should go over repetitive processes for the remaining Model Builders.
For many of the new Model Builders that are constructed, you will be asked to create a new Excel
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FIGURE 1.6 Once the macro security setting is set to “Disable All Macros
with Notification,” the following “Options . . .” button appears when
workbooks with macros are opened.

workbook. It is recommended to get in the habit of using the naming convention we recommend.
This normally follows MBX.Y_User.xlsm. This will let you quickly identify which ones you worked
on and put them in order for later reference. It also means that completed versions on the website
will be filed similarly, since they are named MBX.Y_Completed.xlsm.

FINAL REMINDERS

This is a complex book, perhaps more so than some of the earlier ones in this
series. For each chapter read the theory section carefully, follow the Model Builder
instructions in order (skipping ahead can cause multiple errors), and check the
complete files on the website when lost or simply to compare your version. If
you require more background information or are looking for more advanced
implementations do not forget to read the Appendix and check the corresponding
files on the website. Finally, if you are looking for a deeper discussion on certain
topics there are multiple books that we have recommended throughout this text.
With this in mind, we will move on to Chapter 2 to start developing our skills in
financial simulation.
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